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1. OBJETIVO

Establecer las los lineamientos y procedimientos para el manejo operativo del cromatégrafo de gases Agilent
7890B acoplado al detector selectivo de masas de triple cuadrupolo Agilent 7000D que permitan la puesta en
funcionamiento del equipo.

2. ALCANCE

Este instructivo inicia con el alistamiento y encendido del equipo, continla de manera detallada con el
acondicionamiento, optimizacion, calibracion (Autotune), sigue con la creacion de métodos en el cromatdgrafo
de gases Agilent 7890B acoplado al detector selectivo de masas de triple cuadrupolo Agilent 7000D y termina
con la operacion del equipo para la determinacién de los compuestos de interés.

3. DEFINICIONES

Autotune: ajuste automatico de los parametros del espectrémetro de masas para el compuesto de calibracion,
en este caso, perfluorotributilamina. Cuando se ejecuta el Autotune, un ajuste y calibracién son realizadas
automaticamente con los parametros cargados en el archivo del tune.

Cromatografia de gases: método de separacion de mezclas complejas a través de la reparticion de los analitos
entre la fase estacionaria y la fase mévil (gas inerte).

Columna: tubo capilar de silice fundida recubierto con poliamida y fase estacionaria en donde ocurre la
separacion de los compuestos.

Espectrometria de masas: es una técnica analitica mediante la cual 4tomos o moléculas son ionizados y
separados por su relacion masalcarga (m/z).

Inyector: modulo de introduccion de la muestra al sistema cromatogréfico utilizando una jeringa. La muestra
inyectada es vaporizada y conducida a la columna capilar por medio del gas de arrastre.

Triple cuadrupolo: analizador de masas tandem que consiste en dos cuadrupolos y un hexapolo o celda de
colision ubicada entre los dos cuadrupolos. La funcién de dicho analizador es separar los iones generados; el
primer cuadrupolo dirige el flujo proveniente de la cdmara de ionizacion hacia la celda de colisiones donde los
iones son fragmentados mediante el uso de un gas inerte como nitrégeno y helio. Los iones generados son
dirigidos al segundo cuadrupolo donde son separados y dirigidos al detector. En cada cuadrupolo la separacion
los iones depende de su relacion masa carga (m/z).

Tuning: proceso de ajuste que optimiza la eficiencia del espectrémetro de masas. El objetivo es maximizar la
sensibilidad manteniendo una resolucion aceptable, asegura la asignacion de masas precisas y proporciona las
abundancias relativas deseadas en el espectro.

4, ASPECTOS DE SEGURIDAD Y SALUD EN EL TRABAJO

Procedimientos operativos o practicas no realizadas de forma correcta podrian resultar en dafio del instrumento
0 pérdida de datos importantes. No proceder més alla de un aviso de precaucion o peligro hasta que las
condiciones indicadas se entiendan y sean cumplidas.

Realizar el mantenimiento y verificacion del equipo con los elementos de proteccion personal evitando introducir
contaminantes en el sistema que afecten el funcionamiento del instrumento.

Para realizar las técnicas analiticas relacionadas con este instructivo, deben tener los EPP necesarios para su
desarrollo. Revisar el Manual del sistema en seguridad y salud en el trabajo — SGSST  E-SGI-ST-M001.
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5.

EQUIPOS, REACTIVOS Y MATERIALES

5.1. Equipos

Los componentes basicos del instrumento son:

Sistema de vacio.

Cromatografo de gases (GC) Agilent serie 7890B.

Espectrémetro de masas Agilent Triple Quad serie 7000D.

Muestreador automatico de liquidos Agilent 7693.

Fuente de gas.

Software de adquisicion y tratamiento de datos MassHunter Data Acquisition.
Firmware Ver anexo 1

5.2. Reactivos

Gas inerte nitrgeno (N,) o argén grado de pureza 5.0 (99.9995%)
Gas helio (He) grado de pureza 5.0 (99.9995%)
5.3. Materiales

No aplica

6.

LIMITACIONES E INTERFERENCIAS

Se requiere que el instrumento sea operado por un profesional con experiencia relacionada en la técnica de
cromatografia de gases acoplada a detectores selectivos de masas.

No encender el horno a altas temperaturas hasta asegurarse que el gas de arrastre esté corriendo por el
sistema. La temperatura del horno y de la interface nunca debe estar por encima de la temperatura maxima
permitida de la columna.

Verificar la presion en el cilindro de helio. La vélvula del cilindro debe estar abierta y la presion mayor de
300 psi; presiones menores pueden introducir interferencias y contaminantes en el sistema. Si la presién es
menor se debe cambiar el cilindro.

El espectrémetro de masas debe estar conectado a una fuente de alimentacion ininterrumpida (UPS) que
permita proteger el equipo en caso de fallas generados por picos o caidas de tensién o interrupcién de la
energia eléctrica. El voltaje de operacion es de 120VAC £ 10%.

6.1. Condiciones ambientales

La temperatura recomendable para la operacion del equipo debe estar en el intervalo entre 13a 35 °Cy la
humedad relativa entre 25-95 %.

T.

CONTROL Y ASEGURAMIENTO DE LA CALIDAD

El aseguramiento de la calidad del funcionamiento del equipo puede ser verificado a través de las calibraciones
y ajustes realizados por el sistema: Check air and water, Autotune y Check tune. Debe realizarse el cambio
periddico de consumibles que se desgasten y el mantenimiento preventivo del equipo.

8.

DESARROLLO

8.1. Principio del método

La cromatografia de gases (GC) es una técnica de separacion en la que los componentes de una mezcla se
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reparten entre dos fases: una fase estacionaria, con una grande area superficial, y una fase mévil, que es un
gas inerte. En esta técnica la muestra se vaporiza y es transportada por la fase movil conocida como gas de
arrastre a través de la columna que contiene la fase estacionaria. Los componentes de la mezcla o analitos son
separados con base en sus presiones de vapor relativas y su afinidad por la fase estacionaria y posteriormente
llegan al detector, cuya respuesta es mostrada en el monitor.

La espectrometria de masas (MS) es una técnica que permite estudiar las masas de &tomos, moléculas o
fragmentos de moléculas. El analisis por espectrometria de masas permite obtener espectros de masas, en el
que las moléculas gaseosas se ionizan, los iones se aceleran en un campo eléctrico y posteriormente se
separan segun su relacién masa/carga (m/z).

Un espectrometro de masas unido al cromatdgrafo de gases es conocido como detector de masas o detector
selectivo de masas (MSD, Mass Selective Detector, por sus siglas en inglés). La espectrometria de masas se
basa en el anélisis iones que se mueven a través de vacio.

Uno de los analizadores de masas mas usados en el acople GC-MSD es el analizador cuadrupolar, que es un
analizador de barrido conocido como cuadrupolo o filtro de masas. En la actualidad la utilizacién de mas de un
analizador en una configuracion multidimensional lo transforma en un detector especifico. Esta configuracidn
también es conocida como tandem (MS/MS). Uno de las configuraciones mas comunes de espectrometros de
masas en tdndem es el triple cuadrupolo (QQQ o QqQ). Los componentes basicos del GC-QgQ consisten en
una fuente de ionizacion, un cuadrupolo (Q1), una camara de colisiones (Q2), un segundo cuadrupolo (Q3) y
un detector.

Un modo de analisis méas utilizado en el QqQ es el monitoreo de reaccion multiple (MRM, Multiple Reaction
Monitoring). En este modo de andlisis, la fuente de ionizacion produce los iones, el Q1 es el primer filtro de
masas que permite la seleccionar el ion de interés, llamados de iones precursores. En la camara o celda de
colisiones (Q2) ocurre la fragmentacion del ion precursor y el Q3 actua como un segundo cuadrupolo filtrando
el paso de los iones productos seleccionado para permitir que lleguen al detector.

Este instructivo describe el procedimiento para el manejo adecuado en rutina del equipo. El equipo consta de
un espectrometro de masas (MS) de triple cuadrupolo marca Agilent serie 7000D, cromatdgrafo de gases (GC)
marca Agilent GC serie 7890B, con muestreador automatico de liquidos (ALS, Automatic Liquid Sampler, por
sus siglas en inglés) serie 7643 con bandeja para 150 viales (ver Figura 1), conectados a un computador con
el soffware para manejo y adquisicion de datos marca MassHunter Workstation Version B.07.05. El equipo
también puede ser operado desde el panel de control de operaciones del GC. Dentro del paquete del software
incluye el Data Acquisition, Quantitative Analysis y Qualitative Analysis.

Desde el software MassHunter Data Acquisition se puede iniciar y detener el instrumento; revisar la
configuracidn del equipo en tiempo real; crear, editar, ejecutar, y cargar un método; crear, editar, comprobar y
ejecutar una secuencia, evaluar los parametros del MS, supervisar las condiciones en tiempo real de los
parametros del instrumento. Si es necesario se puede utilizar el menl Help o el boton Help en cualquier cuadro
de dialogo para acceder a Help en linea para el software MassHunter Data Acquisition.

El sistema cuenta con una coleccion de manuales, videos, guias de familiarizacion, aplicaciones de usuario y
herramientas de desarrollo de métodos en idioma inglés para consultarlos en caso de dudas. Los archivos se
encuentran en medios magnéticos en:

e Agilent GCy GC / MS Manuales de usuario y herramientas DVD set.
o Agilent GC | MS Software Informacion y manuales memory stick.

También es posible ingresar desde los accesos directos disponibles en el DESKTOP del computador
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Figura 1. Sistema de triple cuadrupolo Agilent 7000D, con cromatdografo de gases Agilent 7890B y
muestreador automatico de liquidos ALS.

8.2. Encendido del equipo

Antes de proceder a encender el equipo, verificar las condiciones basicas del sistema para que sea puesto en
funcionamiento evitando dafios o problemas.

i.  Abrir las valvulas de los cilindros de gases de helio y nitrdgeno ubicados en la caseta de gases. El helio
se utiliza como gas de arrastre y el N, para la camara de colisiones activadas.

ii. Revisar que la presion en los cilindros sea mayor de 300 psi. Sila presion es menor se debe realizar el
cambio de cilindro inmediatamente.

iii.  Llenar el control de gases que se encuentra en la caseta de almacenamiento de gases.

iv.  Abrirlas valvulas de lalinea de gases ubicadas en el area instrumental de cromatografia. Verificar que la
presion de entrada de cada gas se mantenga alrededor de 80 psi.

v.  Conectar todos los equipos a la fuente de poder regulada por la UPS de 6 KVA, incluyendo el computador.
Verificar que la UPS esté funcionando correctamente. Las baterias deben estar full y la carga que esta
consumiendo el equipo debe ser aproximadamente del 10% de la capacidad de la UPS.

vi.  Revisar el nivel de aceite de la bomba mecanica. Realizar el cambio del aceite cada 6 meses, maximo
cada afio. La bomba mecanica debe estar con el botén encendido en ON. El nivel del aceite no puede
estar por debajo del limite inferior.

vii.  Encender el computador del cromatografo, esperar que cargue el sistema y digitar el usuario admin y la
contrasefa asignada al analista responsable. También se puede ingresar solamente con el usuario ideam.

vii. ~ Encender el cromatdgrafo de gases con el interruptor de alimentacién del GC que simultaneamente
encendera el muestreador automatico.

ix.  Encender el detector selectivo de masas con el interruptor de alimentacion del MS ubicado en la esquina
inferior izquierda del médulo del detector de triple cuadrupolo. Simultdneamente se encenderé la bomba
de vacio mecénica y se escuchara el ruido caracteristico del arranque del motor.
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Xi.

Ingresar al software MassHunter Workstation Version B.07.05. Hacer doble click en el icono CG-QQQ que
se encuentra en el DESKTOP.

Esperar unos minutos en tanto abre el software y se establece la comunicacion entre el cromatdgrafo, el
detector y el software MassHunter Data Acquisition. Los valores en tiempo real son mostrados en el
Instument Control del monitor del computador.

Nota: Para confirmar la comunicacion del sistema, verificar la conexion oprimiendo el botén options, elegir la
opcién communication en el panel del GC. En el display del GC verificar que aparezca la direccion IP
192.168.254.11 (GC) y 192.168.254.12 (MS).

Xii.

Xiii.

Para accionar el alto vacio en el espectrémetro de masas, ejecutar el procedimiento de PUMPDOWN:
Desde el MassHunter Data Acquisition program ir a la opcién Instrument > MS Vacuum Control o desde
el Instrument Control View dar click en el icono Vacuum Control. Seleccionar la opcién PUMPDOWN; se
abrira una ventana para la opcién de cargar las temperaturas altas de (230/150/150) de la fuente de
ionizacién y los cuadrupolos (MS1y MS2). Dar click en YES, como se muestra en la Figura 2. El sistema
demorara aproximadamente 20 minutos en alcanzar los pardmetros especificados.
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Figura 2. Activacion alto vacio PUMPDOWN.

Verificar los parametros del espectrémetro de masas, velocidad turbo (Turbo 1 Speed, 100 %), alto vacio
(high vacuum, entre 1 x 10-5 - 5 x 10-5 Torr), las temperaturas de la fuente de ionizacidn (Source Temp,
230 °C) y los cuadrupolos (MS1 Quad temp, 150 °C y MS2 Quad Temp, 150 °C), como se muestra en la
Figura 3. El status debe aparecer en color verde y Ready, para esto se debe esperar aproximadamente 2
horas hasta que el espectrometro de masas alcance el equilibrio térmico.

‘ J
Figura 3. Parametros del espectrometro de masas.

CSRITIT
Y ok A St S bt




CROMATOGRAFO DE GASES ACOPLADO AL | Version: 03

6 INSTRUCTIVO DE MANEJO DEL Codigo: M-S-LC-1013

T T— DETECTOR SELECTIVO DE MASAS DE TRIPLE | Fecha: 21/10/2020

IDEAM S5 CUADRUPOLO AGILENT GC 7890B/QqQ 7000D | pzcina: 6 de 20

8.3. Comprobacion del estado del equipo

Se realiza el chequeo para verificar que el sistema no tenga agua ni aire, ademas del ajuste del detector con el
Autotune.

8.3.1. Air and Water Check

Para realizar la prueba de presencia de agua-aire, seleccionar en el Instrument Control el icono Vacuum
Control > Air and Water Check. Seleccionar la opcién de imprimir el informe Print air and water check report.
Antes de realizar la prueba le aparecera un mensaje recordatorio para apagar el flujo de gas de nitrégeno de la
celda de colisiones. Para la verificacion de la conformidad de la prueba se deben cumplir los siguientes criterios:

H,O Relacion 18/69 < 20 %
O, Relaciéon 32/69 <25%
N, Relacion 28/69 <10 %

Si la refacion Naw) : O2%)> 4:1 es un indicio de contaminacion. Por el contrario, si la cantidad de oxigeno es
mayor, puede ser atribuido a una posible fuga, la cual debe ser identificada y corregida.

Nota: todas las fallas deben ser subsanadas antes de realizar el ajuste del detector.
8.3.2. Autotune

Para realizar el ajuste del espectrometro de masas se ejecuta el Autotune en el modo de El (ionizacién
electronica). Desde el MassHunter Data Acquisition program ir a Instrument > MS Tune o desde el Instrument
Control dar click en el icono del MS Tune.

Seleccionar la pestafia de Autotune>Autotune; en el Autotune type dar click en high sensitivity autotune.
En el Autotune Options dar click en Print autotune report, Save tune file when done y dar click en Default
name. Para ejecutar, dar click en el boton de Autotune localizado en el esquina inferior derecha. Esperar hasta
que termine el proceso. El archivo con el informe del Autofune quedara guardado en
D:\MassHunter\GCMS\1\7000\Tune Reports. Seleccione la carpeta del Autotune con la fecha en la que fue
realizada el ajuste. El archivo atunes.eiex.tune.xml debe ser cargado en el método de adquisicion que se va
a utilizar.

A continuacion ejecutar el Check tune para verificar que todos los parametros son satisfactorios para operar el
equipo. Al finalizar evaluar el informe del Check Tune. Verificar que todos los parametros estén conformes con
los valores y limites permitidos por el fabricante; el resultado debe ser OK en todos los parémetros para aceptar
la conformidad del equipo para su uso.

8.4. Apagado del equipo o venteo
Para proceder apagar el equipo cargar el método Apagado.

i. Realizar el venteo desde el software MassHunter Data Acquisition program. Ejecutar Instrument>MS
Vacuum Control. El procedimiento de venteo incluye el enfriamiento de las zonas de alta temperatura del
equipo antes de perder el alto vacio del espectrometro de masas. Un cuadro de didlogo con el estado del
sistema muestra los cambios en progreso del ciclo de venteo.

ii. Esperar hasta que aparezca en la pantalla el mensaje de Vent "READY" y verificar que el horno y la
interface estén a temperatura ambiente antes de cerrar el flujo del gas de arrastre.

jii.  Cerrar la ventana del software MassHunter Data Acquisition program y apagar el computador.
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iv.  Apagar el cromatografo de gases y el espectrometro de masas con el interruptor de alimentacion.
v.  Desconectar los equipos de la fuente eléctrica y cerrar el flujo de gases.

8.5. Configuracion de los parametros del GC

8.5.1. Registrar la columna cromatografica

Ingresar al Instrument >GC Parameters. En el panel izquierdo dar click en Configuration > Columns.
Inicialmente se debe realizar la instalacion en el software de la columna que se va a utilizar en el GC y calibrarla
para mantener dptimas condiciones del flujo en la columna. Para esto debe dar click en el nimero de la columna
que se va a adicionar; después se abrira el cuadro de Edit Properties of Installed GC Column. Seleccionar
la columna desde el catalogo. Si por el contrario la columna no es de marca Agilent, se pueden registrar todos
los datos de la columna de acuerdo con el fabricante. Para adicionar la columna desde el catélogo, dar click en
el botén Select from Catalog.

Después dar click en el botén Create Inventory, se abrira el recuadro del Column inventory. Proceder a
registrar el nimero del serial de la columna en el campo del Inventory Number seguido de OK. El software
llevara el inventario de las diferentes columnas que se utilicen de acuerdo con el serial que se registre.
Posteriormente, seleccionar las partes de entrada y salida en la que estara conectada la columna dentro del
cromatdgrafo. En este caso en el campo del Inlet debera seleccionar Front Inlet y en el campo del Outlet
seleccionar MSD. En el campo Heated By seleccionar Oven.

Nota: si la columna registrada en el software no se va a utilizar inmediatamente en el equipo, se recomienda
establecer el campo del Inlet de la tabla como Unspecified para evitar que genere errores en el célculo de las
presiones y flujos del sistema.

8.5.2. Calibrar la columna en el software

Desde el menu o desde la parte gréfica dar click en Instrument >GC Parameters. En el panel izquierdo dar
click en Configuration > Columns > Calibrate > Calc Length. Registrar el tiempo muerto determinado a partir
de la inyeccion de una sustancia no retenida en la columna en el campo del Holdup time of an Unretained
Peak; en seguida dar click afuera del dato registrado para verificar que se hayan realizado los ajustes. Verificar
los datos de los demas pardmetros (temperature, inlet and outlet pressures, y gas type) utilizados para
determinar el Holdup Time. Actualizar cualquier parametro que sea diferente al utilizado en el método de
adquisicién. Finalmente dar click en Ok.

Al finalizar el proceso, verificar que en las especificaciones de la columna en la tabla del menu Column
aparezca en el item de Calibration result |a fecha de calibracion. De esta forma, se confirmara que se hayan
guardado los cambios de la calibracion.

Para determinar el tiempo muerto inyectando aire, se verifica el tiempo de elucion de los iones de N2 y CO, (m/z
28y 32, respectivamente), a través del cromatograma de ion extraido desde el software Qualitative MassHunter
(ver Seccion 8.8.5 de este instructivo).

8.5.3. Seleccionar los gases para los diferentes médulos desde la configuracion del GC

Ingresar a Instrument >GC Parameters. En el panel izquierdo dar click en Configuration>Modules. Desde la
opcion Front Inlet en el campo de SS Inlet seleccionar el helio: He. Para la opcion Collision Cell/Backflush
en el campo Quench Gas, automaticamente establece el He como gas de arrastre. En el campo de Collision
Gas seleccionar el nitrégeno: N,. Finaimente, para el Backflush Gas seleccionar el helio: He.
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8.5.4. Configurar ALS

Desde la configuracién del GC seleccionar los parametros para el automuestreador ALS. Ingresar Instrument
>GC Parameters. En el panel izquierdo dar click en Configuration > ALS. Ingresar tamafio de la jeringa en
Syringe Size estableciendo 10 pL. En el modo de lavado de solvente para utilizar solamente los frascos Ay B.
seleccionar A, B en Solvent Wash Mode.

8.6. Configurar el detector selectivo de masas de triple cuadrupolo

De acuerdo con la configuracion del detector de triple cuadrupolo, el equipo puede operar en diferentes modos
de monitoreo, a saber: barrido completo (Full Scan), monitoreo de iones seleccionados (SIM, selected lon
Monitoring), barrido de ion producto (Product lon Scan) y monitoreo de reacciones multiples (MRM, Multiple
reaction monitoring y Multiple reaction monitoring dinamic MRM). Las configuraciones de barrido de ion
precursor (Precursor lon Scan), barrido de fragmento neutro (Neutral Loss lon Scan) no son utilizadas en el
Laboratorio de Calidad Ambiental del IDEAM.

El procedimiento para establecer los pardametros del espectrdmetro de masas MS es el siguiente:

i.  Desde el GC-QQQ MassHunter Acquisition software ir al menu Instrument > MS Parameters.
ii. ~ Enelcampo de Method > Acquisition, registrar las informaciones del MS Parameters.
iii.  Enel campo de Tune File, seleccionar el archivo del ultimo Autotune realizado.

iv.  En el campo de Source Parameters, la lon Source esta preestablecida como El. La temperatura de la
fuente o Source Temperature (°C) puede establecerse en 230 °C. Electron Energy Mode, seleccionar
Use Tune Setting y |a energia de ionizacién o Electron Energy (eV) esta predeterminada como 70 eV.

v.  En el campo de Detector Setting es recomendado trabajar con el factor de ganancia. Seleccionar Use
Gain Factor.

vi.  En el campo de Run Time es recomendado establecer el tiempo del Solvent Delay (min) para que el
filamento del MS esté apagado mientras eluya el solvente. Tener presente que demasiada humedad puede
quemar el filamento. Ingresar el tiempo de la corrida cromatografia en que se va encender el filamento.

vii.  Enel campo de Time Filter activar dando On y activar las casillas del Automatically Substract Baseline
y Advance MRM/SIM Filtering.

Las opciones para ajustar algunos de los modos de adquisicion del MS en el campo de Time Segments se
exponen a continuacion:

8.6.1. Full Scan

Este tipo de monitoreo es equivalente al que se realiza en un equipo con cuadrupolo unico, es decir, la camara
de colisiones Q2 no esta activada. El triple cuadrupolo QQQ Agilent 7000D permite realizar este tipo de scan
en cualquiera de los dos cuadrupolos (Q1 o Q3). En el software se puede identificar como MS1 Scan o MS2
Scan. En este caso es recomendable que el primer cuadrupolo Q1y la camara de colisiones Q2, estén operando
en el modo de transmision de iones o Total Transmision lon (TTI), permitiendo el paso de todos los iones al
segundo cuadrupolo Q3 que trabajaré como un filtro de masas antes que los iones lleguen al detector. Con las
corrientes ionicas totales se construye el espectro de masas. Preferiblemente se debe trabajar en el modo MS2
Scan dado que el cuadrupolo esta mas cerca al detector.

En el modo de monitoreo del tipo Scan verificar la siguiente configuracion:

e En el campo de Scan Type seleccionar MS2 Scan.
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e En el campo Gain establecer el valor de la ganancia, en el rango entre 1-10.

e Dar click en la casilla del Data Saved. En la regién superior derecha del display, en Scan Segments
establecer el rango de masas en el que se va trabajar. Para esto en la opcion del MS2 Start Mass establecer
el valor de 45 (m/z). En la opcién MS2 End Mass ingresar el valor de 500 (m/z); para analizar masas
mayores es requisito aumentar el rango. En la opcion del Scan Time ingresar un valor en el cual el niumero
de Data samples sea aproximadamente 3.

e Enlaregion inferior derecha del display, en Scan parameters en el campo de Step size (amu) seleccionar
0,1. El valor del Threshold puede establecerse entre 50 o 100.

¢ Finalmente dar click en OK 'y guardar los cambios en Methods > Save.
8.6.2. Monitoreo de ion (es) seleccionado (s), SIV

Se programa uno de los cuadrupolos para que deje pasar solo los iones tipicos y especificos del analito que
fueron previamente seleccionados. Los ofros dos cuadrupolos trabajan en el modo TTI. El equipo permite
trabajar en el modo SIM en cualquiera de los dos cuadrupolos (MS1 SIMy MS2 SIM). Como en el caso anterior,
se recomienda trabajar en el modo MS2 SIM.

En la Figura 4 se muestra un ejemplo para la configuracion del modo de SIM.
i. Enelcampo de Scan Type seleccionar MS2 SIM.

ii. En el campo de Time (min), ingresar el tiempo de retencion del compuesto de interés que puede ser
determinado a través de la adquisicién por Scan. Pueden ingresarse varios segmentos o ventanas de
monitoreo, es decir, el tiempo de retencion para la adquisicion de varios analitos.

ji. ~ Enel campo Gain establecer el valor de la ganancia, puede estar en el rango entre 1-10.
iv.  Dar click en la casilla del Data Saved.

v.  Enlaregion superior derecha del display, Scan Segments ingresar el nimero de filas de acuerdo con la
cantidad de iones que se van a monitorear en ese segmento a través de los iconos = == . Ingresar el
nombre del compuesto que va a monitorear. En el campo de MS2 mass, ingresar la masa de los iones
que desea monitorear. En el campo de MS2 resolution seleccionare la resolucion Wide (1,2 uma) y como
Dwell time (min) ingresar un valor de 50.

vi.  En la region inferior derecha del display, en la opcion de Full Scan parameters, es opcidn habilitar la
adquisicién simultanea de SIMy Scan, dando click en la casilla Enable.

vii. ~ Finalmente dar click en OK'y guardar los cambios en Methods > Save.
8.6.3. Barrido de ion producto (Product lon Scan)

Elion precursor o ion padre se selecciona en el Q1 (MS1) y se transfiere al Q2 (camara de colisiones activadas),
donde interactta con el gas de colision y el gas ionizado de helio, promoviendo la fragmentacidn del ion para
generar los iones productos o iones hijos. Los fragmentos son entonces escaneados en el Q3 (MS2). Esto da
como resultado un fragmentograma tipico de un andlisis tandem MS/MS. EI monitoreo de iones producto sirve
como un paso util en el desarrollo del método MRM o en el caso donde se intenta elucidar la estructura de un
ion precursor.
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Figura 4. Parametros para operar el MS en el modo MS2 SIM

En la Figura 5 se muestra un ejemplo para la seleccidén del modo de ion producto.

Vi.

Vii.

En el campo de Scan Type seleccionar Product lon.

En el campo de Time (min) ingresar el tiempo de retencion del compuesto de interés que puede ser
determinado a través de la adquisicién por Scan. Pueden ingresarse varios segmentos o ventanas de
monitoreo, es decir, el tiempo de retencion para la adquisicion de varios analitos.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre 1-10.
Dar click en la casilla del Data Saved.

En la region superior derecha del display, Scan Segments ingresar el nimero de filas de acuerdo con la
cantidad de iones que se van a monitorear en ese segmento a través de los iconos = = = . En el campo
Segment Name ingresar el nombre del compuesto que va a monitorear. En el campo de Precursor lon,
ingresar la masa de los iones que desea escanear el Producto lon. En el campo de MS1 Resolution
seleccionar la resolucion Wide (1,2 uma). En el campo MS2 Start Mass ingresar un valor de masa menor
para que empiece a hacer el barrido. En el campo MS2 End Mass ingresar un valor masa mayor al del
ion precursor. En la opcién del Scan Time ingresar un valor en el cual el nimero de Data samples sea
aproximadamente 3. En el campo CE (eV) ingresar la energia de colision para realizar la fragmentacion
en la camara de colisiones.

En la region inferior derecha del display se muestra la opcion de Scan parameters: En el campo de Step
size (amu) seleccionar 0,1. El valor del Threshold puede establecerse entre 50 o 100.

Finalmente dar click en OK y guardar los cambios en Methods > Save.
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8.6.4.

-----------

Figura 5. Parametros para operar el MS en el modo de monitoreo de barrido de ion producto.

Monitoreo de reacciones multiples (MRM, Multiple reaction monitoring)

MRM es conocido como la herramienta final de analisis de compuestos que no produce un espectro completo.
Puede producir resultados muy especificos y sensibles. En este modo de adquisicién es seleccionado un ion
precursor del analito en el Q1 (MS1), el ion es fragmentado en el Q2 (camara de colisiones) y al seleccionar un
ion proveniente de la fragmentacion, es decir, un ion producto de la transicion o reaccion de disociacion, sera
filtrado en el Q3 (MS2). Ambos analizadores MS7y MS2 operan en modo SIM. De este modo, solo los iones
producto generados por la fragmentacién del ion precursor pasado a través de Q7 son detectados.

El monitoreo de la reaccion del ion precursor e ion producto permite confirmar la presencia del analito en
mezclas complejas. Asi, la identificacion de dos transiciones independientes ademés de la equivalencia del
tiempo de retencién cromatografico con la de un patron certificado, confirma la identificacion inequivoca del
analito.

En la Figura 6 se muestra un ejemplo para la seleccién del modo de MRM.

En el campo de Scan Type seleccionar MRM.

En el campo de Time (min), ingresar el tiempo de retencidn del compuesto de interés. Pueden ingresarse
varios segmentos o ventanas de monitoreo, es decir, el tiempo de retencidn para la adquisicion de varios
analitos.

En el campo Gain establecer el valor de la ganancia, puede ser en el rango de 1-10.
Dar click en la casilla del Data Saved.

En la region superior derecha del display, Scan Segments ingresar el nimero de filas de acuerdo con la
cantidad de iones que se van a monitorear en ese segmento de tiempo a través de los iconos = == |
En el campo Compound Name ingresar el nombre del compuesto que va a monitorear. En el campo de
ISTD, seleccionar la casilla si va a utilizar estandar interno. En el campo de Precursor lon ingresar la
masa m/z del ion que desea monitorear. En el campo de MS1 Resolution seleccionar la resolucion Wide
(1,2uma). En el campo Product ion ingresar un valor de m/z del ion producto proveniente del ion precursor
que desea monitorear. En el campo MS2 Resolution seleccionar la resolucion Wide (1,2 uma). En el
campo Dwell (min) puede establecer un valor de 50 y en campo de CE (eV) ingresar el valor de la energia
de colision para realizar la fragmentacion en la cdmara de colisiones.
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Nota: la energia de colision debe ser optimizada a fin de obtener la mayor abundancia de la reaccién o
transicion.

vi.  Enlaregion inferior derecha del display se muestra la opcion de Full Scan parameters. Puede habilitarse
la adquisicion simultdnea de MRM y Scan dando click en la casilla Enable. Esto podria disminuir la
sensibilidad para la deteccion de los analitos.

vii. ~ Finalmente dar click en OK'y guardar los cambios en Methods > Save.
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Figura 6. Parametros para operar el MS en el modo MRM.
8.7. Creacion de la secuencia para inyeccion automatica de las muestras.

8.7.1. La creacidn de la secuencia de analisis se hace mediante el menu Sequence del Instrument control.
La secuencia puede ser creada por modificacion del archivo default. Desde el menu Sequence
seleccionar Load Sequence, abrir el archivo default.sequence.xml dando click en el mend
Sequence>Edit Sequence y apareceré la tabla de secuencia:

i.  Enelcampo Name, ingresar el nombre de la muestra, puede contener hasta 30 caracteres. No debe incluir
caracteres especiales (/), (*), (,) o “espacio” y preferiblemente “guion al piso”.

ii. Enelcampo de Method Path seleccionar la carpeta donde se encuentra guardado el método.
ii.  Enelcampo Method File, seleccionar el método que se encuentra dentro de la carpeta del Method Path.

iv.  Enelcampo Data Path, seleccionar la carpeta donde seran guardados los archivos generados durante la
corrida cromatografica.

v.  Enel campo Data File ingresar el nombre con el que quedara guardada la muestra.
vi.  Enel campo Type seleccionar el tipo de muestra.

vii.  En el campo Level opcionalmente seleccionar el nivel de concentracion de la curva de calibracién desde
menor a mayor concentracion. Solo aplica para el tipo de muestra seleccionado como calibrante.

vii. ~ En el campo DIingresar el factor de dilucion de la muestra. Dado el caso en el que no se haya realizado
dilucién ingresar el valor de 1.

ix. En el campo de Vol ingresar el valor del volumen de inyeccion, en el caso en que desee modificar el del
método.
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X.  Los campos Sample Prep P, Sample Prep, Tray Name, no es necesario modificarlos. El equipo del
Laboratorio de Calidad ambiental del IDEAM, no utiliza esta configuracion.

8.7.2.

8.7.3.

8.7.4.
8.7.5.

Guardar la secuencia. Ir al menu de Sequence > Save Sequence As. Ingresar el nombre de la
secuencia inicialmente con la fecha de creacion. Registrar el Afio, mes, dia y nombre de la secuencia.

Realizar la simulacién para verificar los datos y el espacio disponible en el disco duro del equipo.Ir al
menu Sequence > Simulate sequence. Ingresar el nombre del operador y verificar la ubicacion de la
carpeta donde quedaran guardados los datos, o el Data file Directory. Dar click en Simulate sequence.
Revisar que toda la informacion esté correcta y que la ubicacidn de las muestras esté de acuerdo con
el nimero de la secuencia.

Llenar los frascos de solvente A y B, dispuestos en la torre de inyeccion automatica.

Una vez verificado los datos y posiciones de los viales, proceder a ejecutar la secuencia. Seleccionar
desde el menu del Instrument Control |la opcion Sequence > Run Sequence. Dar click en el botdn
Run Sequence para que la secuencia arranque.

8.8. Analisis cualitativo a través del software MassHunter

Inicialmente se realizara una breve descripcién de la interface del Qualitative Analysis MassHunter Version
B.0700 SP2. Este programa permite realizar el andlisis cromatogréfico, ademas de la identificacion de
sustancias por el espectro de masas. Si es necesario se puede utilizar el menl Help o el botén Help en cualquier
cuadro de didlogo para acceder a Help en linea para el software MassHunter Data Acquisition.

8.8.1.

8.8.2.

8.8.3.

8.8.4.

8.8.5.

Para ingresar al software dar doble click en el icono disponible para MassHunter Qualitative Analysis
software en el DESKTOP del computador. Alternativamente, desde el menu de inicio del computador
Programs > Agilent > MassHunter WorkStation > Qualitative Analysis.

El software de Qualitative Analysis MassHunter se divide en cinco éreas definidas en el estandar del
layout. En primer lugar, el Data Navigator lista los archivos de datos abiertos, los cromatogramas
extraidos, los espectros, y los compuestos asociados con el archivo de datos. La ventana del
Chromatogram window muestra los cromatogramas definidos y los cromatogramas de iones extraidos
0 de MS/MS. EI Method Explorer permite seleccionar una funcion y el Method Editor se utiliza para
establecer los parametros para esa funcion que desea.

Para abrir el archivo ir al menu File>Open Data File. Seleccionar el archivo que desea abrir. La ruta
de acceso para los Data file generados después de la corrida cromatografica es
D:\MassHunter\GCMS\1\Data. Deshabilitar la casilla de Load Result data para tener el archivo madre
sin que se guarden las modificaciones. Dar click en Open.

El panel del Data navigator muestra los Data files que son abiertos dentro del Qualitative Analysis
software. El usuario puede seleccionar la informacion del cromatograma que desea observar en el
panel del Chromatogram Window. Asi puede seleccionar o “deseleccionar” la informacion asociada a
esa data File como el cromatograma de la corriente iénica total reconstruida o TIC, en las casillas de
checkbox.

Para ampliar alguna region del cromatograma o del espectro de masas, realizar el zoom dando click
con el botén derecho en la ventana y arrastrar el cuadro alrededor de los datos que desea ampliar o
dando click derecho sobre el eje y arrastrar para hacer zoom. Utilizar los botones de escala automatica
para devolver los datos a la escala inicial.

Extraccion de cromatogramas. El Qualitative Analysis soffware abre inicialmente el cromatograma de
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8.8.6.

8.8.7

iones totales o TIC. Permite ademas realizar la extraccion de otro tipo de cromatograma dependiendo
del método de adquisicion utilizado. Para realizar este procedimiento dar click derecho sobre el
cromatograma y seleccionar Extract Chromatograms; es posible acceder a esta opcién también a
través del menu Chromatograms disponible en la parte superior de la interface. En seguida, se abrira
el cuadro de didlogo en donde podra seleccionar el tipo de cromatograma de desea extraer, las
opciones se muestran en la Figura 7.

Nota: Al seleccionar la opcidn de cromatograma de ion extraido (EIC), ingresar en el campo m/z value
(s) los iones m/z que desea extraer. Finalmente hacer click en OK.

-

Tipos de cromatogramas
TIC - Total lon Chromatogram

BPC — Base Peak Chromatogram

EIC - Extracted lon Chromatogram

SIM — Selected lon Monitor

MRM - Multiple Reaction Monitor-QQQ

Figura 7. Extraccion de cromatogramas.

Superposicion de cromatogramas. Para realizar la superposicion u Overlaid de los cromatogramas,
seleccionar el icono 12k de la barra de herramientas del panel de Chromatograms Results. Para

separarlos, hacer click en el icono EJ

. Integracion de los picos del cromatograma.

Para realizar la integracion dar click derecho en el cromatograma, seleccionar Integrate Chromatograms
o desde el panel de Method Explorer en el campo de Chromatogram seleccionar Integrate (MS) en el caso
de adquisicion por Scan, o también puede ser utilizado Integrate (MS/MS) para integrar datos adquiridos
por MRM. Se abrira la caja de dialogo del Method Editor, en €l cual se recomienda utilizar como el tipo de
integrador en el campo Integrator Selection la opcion Agle o Agile 2. Dar click en
(») Integrate Chromatogram ~

Para ver la tabla de resultados hacer click en el menu View>Integrations Peak List, icono .

Para integracion manual hacer click en el icono .

Para quitar picos que no se deseen integrar. Desde el Method Explorer en la opcion Integrate (MS) o
Integrate (MS/MS), seleccionar el Integrator Selection, puede ser Agile 2, y en la ventana de Peak
Filters, ajustar los eventos de integracion de modo que integre solamente sus picos de interés. En este
caso podria ajustar el pardmetro de la altura de los picos en el campo Filter on, seleccionando Peak
Height. Establecerel filtro segun la &rea relativa o absoluta (Absolute area or Relative area).
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8.8.8.

8.8.9.

8.8.10.

8.8.11.

8.8.12.

Eficiencia de la columna. Es posible evaluar la eficiencia de la columna a través del calculo de nimero
de platos tedricos de una determinada sustancia usando el System Suitability disponible en la caja de
didlogo del Method Editor.

Abrir el archivo corrido en Full Scan con la sustancia a analizar, seleccionar desde el panel del Method
Explorera opcion Integrate (MS), seleccionar el Integrator Selection como Agile 2 e integrar el pico
de interés como se explico en la Seccién

Seleccionar la pestafia Suitability. Habilitar la casilla Enable system suitability calculations. En el
campo de Pharmacopeia seleccione United States Pharmacopeia (USP). En el campo Column void
time ingresar el tiempo muerto en minutos (min). En el campo Column Length |a longitud de la
columna en centimetros (cm), ver Figura 8. Después ir al panel de Method
Explorer>Reports>Common Reporting Options. En Templates, seleccione System Suitability
report. El reporte queda guardado en la carpeta del Data File de la muestra. Evaluar el nimero de
platos tedricos de acuerdo con el historial. Si se presenta una variacién aproximada del 30% del valor
inicial, es probable que la columna esté desgastada y sea necesario cambiarla.

Calculo de la relacion sefial/ruido. El procedimiento para calcular la relacion sefalfruido o Signal to
noise (S/N) puede ser realizado desde el panel de Method Explorer. Desde el campo Chromatogram
seleccionar la opcion Calculate Signal-to-Noise. En seguida abrir la caja de dialogo del Method Editor.
En el campo Signal definition seleccionar Height. En el campo de Noise definition seleccionar ASTM
o0 Auto-RSM. Se recomienda utilizar la opcién Auto-RMS para el calculo de S/N. Dar click enla opcién
Automatic noise region detection. En el campo Desired length ingresar el valor de 0,1 min.

Extraer espectro de masas. Desde la barra de herramientas del panel de Chromatogram Results dar

click en el Peak Selector icono E]- y seleccionar el pico de interés. Después dar click derecho sobre
el pico y seleccionar Extract Peak Spectrum.

Extraer background del espectro. Seleccionar la region del background que se desea extraer, dar click
derecho. Seleccionar Extract MS Spectrum to background. Ir al espectro de masas dentro del panel
del MS Spectrum Results, dar click derecho y seleccionar Move to background Spectrum. Ir al
cromatograma y extraer el espectro de masas del pico o la regidn en la que desea substraer el
background. Hacer click derecho sobre el espectro de masas y seleccionar Substract Background.

Identificacion de compuestos. Configurar primero la busqueda con la libreria NIST 2014, disponible en
el Laboratorio de Calidad Ambiental del IDEAM. Desde el panel del Method Explorer, dar click en el
campo Identify Compunds y seleccionar Search Library. Luego, abrir la caja de dialogo del Method
Editor. En la seccidn de Library seleccion, adicionar la libreria dando click en el botén Add Library y
escoger la libreria NIST14, hacer click en Open. Establecer como valor de Score el 80 %. En seguida
en el campo del Search Opcion dar click sobre la flecha y seleccionar la opcion Search Library for
Spectra. Cada vez que se desee buscar el compuesto de acuerdo con el espectro de masas, se puede
dar click derecho sobre el espectro y seleccionar Search USING NIST MS Program.

8.9. Analisis cuantitativo a través del software MassHunter

El Quantitative Analysis MassHunter Version B.07.01 SP2 permite realizar la cuantificacién de un lote de
muestras a través de la creacion de un método de andlisis.
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Figura 8. Eficiencia de la columna, System Suitability.

Para ingresar al software dar doble click en el icono disponible para MassHunter Quantitative Analysis
QQQ en el DESKTOP del computador. También se puede hacer desde el menu de inicio del
computador por Programs > Agilent > MassHunter WorkStation > QQQ Quantitative Analysis.

Nota: existen varias versiones del software para analisis cuantitativo: si la adquisicion de datos se
realiz6 en el modo de operacion de Full Scan o SIM, seleccionar el icono del MS Quantitative Analysis.
Si el andlisis fue realizado en el modo de operacion de MRM utilizar el QQQ Quantitative Analysis.

Al comenzar el QQQ Quantitative Analysis, se abrird el programa con el disefio inicial o layout de
default. La creacion del método de cuantificacion es realizada en pasos sucesivos, a saber: Crear lote,
Adicionar muestras, Crear método, Editar método, Validar método, Analizar el lote y Crear reporte.

8.9.2.1. Crear lote. Seleccionar File > New Batch. Buscar el directorio o carpeta que contiene los data files

del lote que desea analizar. Ingresar el nombre del lote en el campo File namey después seleccionar
el botén Open, como se muestra en la Figura 9.

8.9.2.2. Adicionar muestras. Seleccionar File > Add Samples. Se abrira la caja de dialogo del Add Samples.

Seleccionar las muestras, los calibrantes, los controles, entre otros data file que va a analizar (véase
Figura 9). Usar Browse to Copy Samples para adicionar muestras de otros directorios o carpetas en
este lote de analisis, dar click en OK.

8.9.2.3. Crear método. Seleccionar Method > New > New Method from Acquired MRM Data. Como el método

es nuevo primero se debe editar seleccionando Method > Edit.

Nota: cuando ya esta el método creado, se puede abrir el método después de crear el lote. Para esto
seleccionar Method>Open>0pen Method from Existing File.
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Figura 9. Creacion del lote y adiciéon de muestras.

8.9.2.4. Editar método. Desde el menl Method, seleccionar Edit. En seguida se abrira la interface del mddulo

fi.

fif.

de Method Task. Se describe como realizar las modificaciones en el panel de Method Setup Task.
MRM Compound Setup

Iniciar creando los compuestos. Seleccionar la pestafia del MRM Compound Setup. Ir a la ventana del
Method Table, dar click derecho y seleccionar New Compound. Registrar los datos en la tabla
correspondiente a los parametros del ion de cuantificacion (Quantifier), como se muestra en la Figura 10.
En el campo de Name ingresar el nombre del compuesto. En el campo de Scan seleccionar MRM. En el
campo de Type seleccione target. En el campo Precursor ion seleccionar el m/z del ion precursor. En el
campo de Product lon seleccionar el m/z del ion producto. Estos iones deben corresponder a la transicion
del ion de cuantificacion. En campo RT ingresar el tiempo de retencién de cada compuesto.

Nota: Al trabajar con estandar interno (ISTD, Internal Standard) incluir el compuesto en esta tabla y en el
campo Type, seleccionando ISTD.

Retention Time Setup

Seguir con la edicion del tiempo de la ventana de visualizacion de cada compuesto. En el panel del Method
Task seleccionar la opcién Retention Time Setup; a continuacién desde el panel del Method Table en
el campo RT Delta establecer una variacion de 0,5 minutos a partir tiempo de retencion para cada analito
ISTD Setup. Al realizar cuantificacion con estandar interno seleccionar el ISTD para cada analito. Desde
el panel del Method Task seleccionar la opcion ISTD Setup. I luego a la ventana del Method Table. En
el campo ISTD Compound Name escoger el ISTD para cada analito. En el campo de ISTD Flag
seleccionar la casilla para activar el ISTD para el analito. En el campo ISTD Conc ingresar la concentracion
del estandar interno.

Concentration Setup

Editar la seccidn de las concentraciones de los calibrantes del método. Desde el panel del Method Task,
seleccionar la opcion Concentration Setup. Realizar luego las modificaciones desde la ventada del
Method Table:

1. Crear primero los niveles de la curva de calibracion. Ir a la tabla del método y dar click derecho sobre
la regién del nombre del compuesto. Seleccionar luego la opcién 21 New Calibration Level y repetir
el proceso para cada nivel de la curva que desea incluir. Inmediatamente, se generara la tabla de la
calibracion.
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2.

3.
4.
5.

8.9.2.5.

8.9.2.6.

@ Click derecho
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Figura 10. Crear nuevo compuesto.

Ingresar un prefijo para el nivel de la calibracién en el campo Level. Recomendable ingresar el mismo
dato que se incluyd en la creacion del lote ya que el software utilizara la respuesta del area
cromatografica del Data File respectivo a ese nivel para realizar la curva.

En el campo Conc ingresar la concentracion de cada uno de los niveles de la curva en orden creciente.
Desde la Tabla del Quantifier en el campo Units seleccionar las unidades de concentracion

De ser iguales las concentraciones de los niveles de calibracion de todos los analitos, pueden ser
copiados los datos para los demas compuestos. Ir al menU de la ventana del Method Table, dar click
derecho. Seleccionar luego Copy Calibration Levels To,y seleccionar los compuestos con la misma
concentracion en los niveles de calibracion. Finalmente dar click en OK.

Qualifier Setup

Adicionar las transiciones MRM de los iones de confirmacion para cada compuesto. Desde el panel
del Method Task seleccionar la opcién Qualifier Setup. Ir al panel de navegacion del Method Table,
seleccionar el nombre del compuesto al que se va a adicionar la transicion y dar click derecho sobre
este nombre. Seleccionar la opcién £ New Qualifier.

En la tabla del Qualifier seleccionar las masas de los iones (m/z) de cada transicion de la reaccion.
Ejemplo: seleccionar el Precursor lon y Product lon FIRnfirmacién (Qualifier) en porcentaje (%) en
relacion al area del ion de cuantificacion (Quantifier). En el campo de Uncertainty, ingresar el
porcentaje de incertidumbre en la relacién del area del Qualifier y Quantifier. (El software establece
por default un valor del 20%). Repetir este procedimiento para cada uno de los analitos.

Validar método. Desde el panel del Method Task ir el menU del Save/Exit y seleccionar la opcion
Validate. Si todo esta correcto aparecera el cuadro de didlogo en donde indica que no fueron
encontrados errores. Si es detectado algun error, lalista de errores aparecera en la parte inferior debajo
de la ventana de Compund Information. Guardar el método de cuantificacion en Save as.

Analizar el lote. Después de verificar y salvar el método, dar click en Exit. EI programa preguntara si
desea aplicar este método al lote. Seleccionar Analyzed>OK.

El software analizara el lote y retornara a la interface del panel de navegacion del Batch Table en
donde calculara la ecuacidn de la curva de calibracidn y la concentracion de las muestras incluidas en
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8.9.2.7.

el lote. Para adicionar mas muestras a analizar en el lote, ir a File> add simple. En este caso se debe

. . , = Analyze Batch - . . . v
analizar el lote de nuevo damdp click en el icono. = “™¥*2" *| Realizar correcciones con integracion
manual del &rea del pico cromatdgrafo cuando sea necesario. Guardar el andlisis cuantitativo del lote
antes de salir, incluso para generar el reporte dando File > Save Batch.

Generar el reporte. Después de analizar el lote y verificar los resultados, guardar los cambios y
generar el reporte seleccionando Report > Generate. Se abrird el cuadro de didlogo del Generate
Editor. Seleccionar el Report Folder o carpeta donde se guardaré el reporte desde el botdn Browser.
Luego en el campo del Report method editar el tipo de reporte a generar dando click en el botén Edit,
y se abrira una caja de didlogo. Para comenzar a establecer |as caracteristicas del reporte adicionar el
Template. Para esto hacer click en el boton Add Template y seleccionar el archivo desde el directorio
siguiendo la ruta D:\MassHunter\Report Templates\Quant\en-us\letter\Parts_Grafics. En esta carpeta
aparecen varias opciones de modelos de reporte. Se puede seleccionar el
QuantReport_ESTD_Complete. Continuar configurando los demas campos del Report Method Edit.
Ver Figura 11.

En el campo de Report mode seleccionar Batch.

En el campo destination file, establecer el nombre de default del template. Recomendable no cambiar.
En el campo de Publish Format, seleccionar el XLSX que corresponde al formato en Excel.

En el campo de Printer, seleccionar la impresora en PDF CutePDF Writer.

En el campo Open published File dar click en la casilla para que abra el archivo después de generarlo.

vi. Dar click en Save & Exit. En seguida retornara al cuadro del Generate Report. Seleccionar Generate

report now > OK. Esperar hasta que se genere el reporte.
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Figura 11. Editar y adicionar el modelo para crear el reporte del lote.

8.10.Formatos
M-S-LC-F023 Formato control de gases
M-S-LC-F007 Formato control diario del manejo de equipos

M-S-LC-F021 Formato condiciones ambientales
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Anexo 1. Firmware

59 GC Status GC-MSD QQQ i iy =t

Agilent 78908 at IP Address: 192.168.254.11 (4]
Serial Number: CN16473139 ]
Firmware Revision: B.02.04.3
Product Version: 3.0.527

Driver Version: DSA GC 7.0 [527]
MSD Address: 0.0.0.0 I

MSD Communication: Off

PC Clock: 9/3/2019 8:56:34 AM
GC Clock: 9/3/2019 8:56 AM
GC Connection State: Online ’

GC RunState: Run
ALS Run State: Injecting I

Injection Request:
Front Injector using Tray Vial #2
GCRun Time: 22.2 min
l Run Time: 0.3 min

GC Mode: Normal
GC Ready State: Ready

Host: Not Ready EJI |




